Downtime Handbook

Earn respect in the workplace by staying positive, proactive and productive.
Table of Contents

1) Preface
2) Be Positive
3) Be Proactive
4) Be Productive
5) Business Letter Format
6) Tips for Organizing Outlook E-mail
7) Guide to Writing an Effective Cover Letter
8) Cover Letter Template
9) Resume Template
10) Resume Sample
11) Job Description Template ("Addendum A")
12) Job Description Sample (Sacramento Air District)
13) Job Description Sample (Crocker Art Museum)
After going through options provided in your downtime handbook, ask your supervisor(s) what you can be doing to help the office. It is important to be proactive in finding work and remaining a productive employee. Your positive attitude and productive work days will earn you a favorable reputation among your co-workers and supervisors and with that will come more opportunity.

Be Positive

Be Proactive

Be Productive

“Start by doing what's necessary, then what's possible; and suddenly you are doing the impossible.”

Saint Francis of Assisi (1181-1286)
Be Positive

Keep a positive attitude in the workplace by continuing to learn about the job and by striving to improve your performance.

1) Check in with your supervisor and/or other appropriate people in the office and ask how you can be of help. Be proactive in seeking out ways to help—you might see something you would be capable of doing... just do it!

2) Learn people’s names. Challenge yourself to use your co-workers names, for example: “Good morning, Mary.” When you have common breaks with co-workers, go the extra step to find out what they do and maybe even how they got there. You’re likely to learn something valuable for your own future.

3) Learn someone else’s job. There is no such thing as “that’s not my job.” Your job is to assist in any way possible and to make the lives of the other people in the office smoother and easier. Take every opportunity to learn what other people do and how you can help them. If you learn another position well enough, it could result in a future promotion.

4) Ask what you can do to improve your performance at work. This is a great way to really excel at work.

5) If you have a particular career interest, your supervisor(s) may be able to set up a job shadow for you or get you connected to mentors. You have an incredible set of resources in your supervisor and co-workers.

*It is an expectation that you will continue to learn more and take on more responsibility as you become more experienced on the job. People move up the ladder by proving themselves with the small stuff and building trust with co-workers. When your co-workers see that they can depend on you to complete a task with competence and a positive attitude, they will allow you to do more complicated tasks. Build trust!*
Be Proactive

Find tasks to do when work seems slow.

Earn recognition and respect from your supervisor and co-workers by striving to be proactive and productive during all work hours. You will find that as you gain recognition for working diligently, you will be given more opportunities for taking on more substantial projects. Follow the prompts below to help you remain proactive even during slow times at work.

Tasks to complete:

1) Organize your work area and files.
2) Organize your emails. Create folders and file each message.
3) Clean/organize a common space such as the break room or copy room.
4) Research the company where you work and create a PowerPoint presentation on your company.
5) Ask for permission to update the company’s social media.
6) Use the business letter template (pg. 6) to write your supervisor a letter expressing your gratitude for being part of the company and persuade them to include you in new projects by sharing what you have learned. Include details of the job that you like and specific tasks and skills that you are looking forward to learning.
7) Read the job description for your position to help familiarize yourself with the details of your job. If there is not a job description available, write a job description for yourself. To do this, carefully think about your job responsibilities and write them down. (Contact Work-Study for assistance with writing your job description.)
8) Go to freetypinggames.net to practice your typing skills. Impressive typing skills are valuable in virtually any job. (Ask for supervisor’s permission.)
9) Go to www.gcflearnfree.org to practice with Microsoft Word and Excel tutorial programs. (Ask for supervisor’s permission.)
Be Productive

Recognize what you can do to stay productive at your specific work site.

Create a custom list of downtime activities and have them approved by your supervisor. Start your list by thinking about tasks your supervisor gave you the last time you asked for something to do during downtime.

1) __________________________________________
   __________________________________________
   __________________________________________

2) __________________________________________
   __________________________________________
   __________________________________________

3) __________________________________________
   __________________________________________
   __________________________________________

4) __________________________________________
   __________________________________________
   __________________________________________

5) __________________________________________
   __________________________________________
   __________________________________________

6) __________________________________________
   __________________________________________
   __________________________________________

7) __________________________________________
   __________________________________________
   __________________________________________

8) __________________________________________
   __________________________________________
   __________________________________________

9) __________________________________________
   __________________________________________
   __________________________________________

10) __________________________________________
    __________________________________________
    __________________________________________

Supervisor Signature: __________________________________________
Business Letter Format

Your Street Address
Your City, State Zip
Date

First and Last Name of the Person to whom you are writing
Their Street Address
City, ST Zip

Dear Mr./Ms. Full Name:

You do not want to indent when you are using this format. This is the best format to use when you are writing a persuasive letter. You want to introduce yourself and the topic you are writing about to the reader. Remember that the first rule of writing is to know your audience. In a persuasive letter, you state your opinion or your feelings about something that is important to you after you have introduced yourself. You must sound as professional and passionate as possible. You do not want to belittle the reader or they will not finish reading your letter. Your letter needs to have the facts, reasons, and examples to support your position. Address issues that your reader may have in their argument.

In a second paragraph, you must have solutions. Without solutions, you are only complaining. Offer assistance in solving the problem. Remind the reader where they can contact you.

Sincerely yours,

A. Student

http://www.scholastic.com
Tips for Organizing Outlook E-mail


- Set a reminder to reply to a message. Right-click the message you want to set the reminder for, point to Follow Up, and then click Add Reminder. In the Due By list, click the date when you have to complete the reply. In the second list, click a time. In the Flag color list, click the flag color you want, and then click OK.
- Send a message to multiple people without revealing other recipients' identities. To send a message to someone without other recipients of the message knowing, use the Bcc line in the message. Bcc stands for blind carbon copy. If you add someone's name to the Bcc line, a copy of the message is sent to that person, but his or her name is not visible to other recipients.
- Find related messages. To find related messages, right-click the message, and then on the shortcut menu, point to Find All and then click Related Messages. The Advanced Find dialog box appears with a list of related messages.
- Jog your memory with a follow-up flag. Create a follow-up flag as a reminder to follow up on a message. On the Actions menu, click Follow Up and click the flag color of your choice.
- Save searches that you use often. On the Tools menu, point to Find and then click Advanced Find. In the Advanced Find dialog box, specify your search criteria and click Save Search on the File menu. You can share the search results with others by sending the search results file as an attachment in an e-mail message.
- Search for and move items or files to different folders. On the Tools menu, point to Find and then click Advanced Find. In the Advanced Find dialog box, specify your search criteria and click Find Now. After the results are displayed in the search results window, move them to the folder of your choice.
- Use a file shortcut instead of an attachment to reduce the size of a message. Right-click the file and drag it to the Inbox. On the shortcut menu, click Send with Shortcut.
- Sort messages alphabetically by sender name. To sort, click Arranged By and then click From. To reverse the alphabetical order, click From again. To sort by Subject line, click Subject. You can sort this way in any table in Outlook.
- Receive notifications when messages you send are delivered or read. On the Tools menu, click Options, and then click the Preferences tab. Click E-mail Options, and then click Tracking Options.
- Quickly mark a message as read. Right-click the message and then click Mark as Read.
- Make a folder available for online and offline use. Right-click the folder, click Properties, and then click the Synchronization tab. The folder must be on your network, not on your hard disk.
- Want to move an Inbox item to a folder in the Navigation Pane but can't see the folder? Drag the item to the top or bottom of the group and pause until the correct folder scrolls into view. Subfolders must be expanded to view them.
• **Recall that message!**  To recall or replace a sent message, open the message in the Sent Items folder, and on the Actions menu, click **Recall This Message.**

• **Automatically add a signature or logo to each message you send.**  On the Tools menu, click **Options,** and then click the Mail Format tab. If you have more than one account, select the account you want to create the signature for, and then click **Signatures.**

• **Keep track of messages that require action.**  Instead of just using rules to move messages to folders, use rules to assign a category to a message. Then the messages will be arranged in groups in your Inbox.

• **Quickly test the hyperlink in the message you just wrote.**  Press CTRL while you click the hyperlink.

• **Speed up exporting and archiving items.**  Make exports and archives of your Outlook mailbox faster by emptying the **Deleted Items** folder first. Right-click the **Deleted Items** folder, and then click **Empty "Deleted Items" Folder.**

• **Does your mailbox need a quick cleanup?**  On the Tools menu, click **Mailbox Cleanup.** Select options to find items that are old or large and then move or delete them. Click **AutoArchive** to move old items to **Archive Folders,** or click **Empty** to permanently delete items from your **Deleted Items** folder.

• **Choose which e-mail account to use.**  If you have multiple e-mail accounts in Outlook, you can choose which to use when sending messages. For example, choose your Hotmail account, and recipients receive the message from that account, complete with your Hotmail return address. In a new message, click **Accounts,** and then click the account you want from the list.

• **The mail folder list is just a click away.**  To quickly view the **Folder List,** click **Folder List** in the button tray at the bottom of the **Navigation Pane.**

• **Change in priorities? Quickly change the color of a message's Quick Flag.**  Locate the flagged message in the message list. Right-click the flag, and then click the flag color that you want on the shortcut menu.

• **Make sending a file through e-mail even easier.**  You can send a file on your computer through e-mail by right-clicking the file, pointing to **Send To,** and then clicking **Mail Recipient.** Text is automatically added to the body of the message; however, you can delete the text and add your own text by clicking in the message body and pressing CTRL+A.

• **Create a Search Folder quickly from the Find bar.**  Press CTRL+E to open the Find bar, type what you want to find in the **Look for** box, specify which folder to look in by using the **Search In** box, and then click **Find Now.** When the search is complete, click **Options** on the Find bar, and then click **Save Search as Search Folder.**

• **Find all messages sent by the same person.**  Right-click a message from that person, and then on the shortcut menu, point to **Find All.** Click **Messages from Sender.** The **Advanced Find** dialog box displays a list of all messages in a folder from that person.

• **Quickly add an attachment to a new message.**  Locate the file, for example a .doc file in your **My Documents** folder, and then drag it to your Inbox. Outlook opens a new e-mail message with the file attached. You can also drag multiple files.

• **Flag that message fast.**  Select a message in the message list, and then press INSERT.

• **Was an important message sent to the Junk E-mail folder?**  If an item gets moved to your **Junk E-mail** folder by mistake, select the message, and then press CTRL+ALT+J.
• **Save multiple attachments at one time.** Open the message. On the File menu, click Save Attachments. Click OK, and then click the folder where you want to save the attached files. Click OK.

• **View all your unread messages in the Inbox.** On the View menu, point to Arrange By, point to Current View, and then click Unread Messages in This Folder.

• **Create a rule from a message.** Right-click the message, and then click Create Rule. Select the conditions and actions you want to apply, and then click OK.

• **Start fresh! Clear your address history.** To clear your AutoComplete cache, open the C:\Documents and Settings\user name\Application Data\Microsoft\Outlook folder, and then delete the profile_name.nk2 file. Outlook recreates this file as you type new addresses.
Guide to Writing an Effective Cover Letter

A cover letter is just as important as your resume. It is an opportunity to personalize your resume and sell your skills. Include these important sections in your cover letter:

- **Heading and greeting**
  Include the date, your name and your contact information. Address the letter to a specific name and/or title whenever possible.

- **Opening and introduction**
  Explain who you are and your reason for writing, including how you found out about the position.

- **Body**
  Sell yourself. Reveal why you are a perfect and unique match for the position. Explain why you have chosen the employer.

- **Assertive closing**
  Politely take initiative toward further action and next contact.

Don’t use a generic, form-like cover letter. Use these tips to write a fresh and informative cover letter:

**Be confident, positive, and focused**

- Target your letter to the audience and industry.
- Be positive about your current employment situation and professional future.
- Emphasize what you can offer the employer.
- Express your focused career goals.
- Don’t use empty or unproven claims about your abilities.

**Be concise, accurate, and polite**

- Use short sentences.
- Keep the letter to one page.
- Proofread your letter thoroughly.
- Thank the reader for his or her time.
- Sign your cover letter — blue ink is best to show the letter is an original.

CareerOneStop is sponsored by the U. S. Department of Labor, Employment and Training Administration

http://www.careeronestop.org
Your Name  
Street Address  
City, State Zip Code  
Phone Number  

Date  

Individual's Name  
Job Title  
Name of Organization  
Street Address  
City, State Zip Code  

Dear Mr./Ms. __________________________:  

**First Paragraph:** State the reason for writing. Name the specific position or type of work for which you're applying. Mention how you learned of the opening.  

**Second Paragraph:** Explain why you're interested in working for this employer and specify how you're PERFECT for this position. Don't repeat the information on your resume. Include something special or unique about yourself that will benefit the employer. Remember, the reader will consider this an example of your writing skills.  

**Third Paragraph:** Mention that your resume is enclosed and indicate your desire to meet with the employer. You may want to suggest alternate dates and times, or simply advise them of your flexibility to the time and place. Include day and evening contact information. Include a statement or question that will encourage the reader to respond. Be sure to communicate your plan to follow up. You might state that you'll be in the area on a certain date and would like to set up a meeting, or you'll call on a certain date to set up a meeting. Finally, thank the employer for his/her time.  

Sincerely,  

(Your Signature in blue or black ink)  
Your typed name  

Enclosure  

Source: [Creative Job Search](http://www.creativejobsearch.com), a publication of the Minnesota Department of Employment and Economic Development.
Combination Resume Template: Instructions
This template is a general format. Actual content and layout will vary. Not all items are required or necessary. Replace the content prompts with your own information to create your resume.

First and Last Name
Address Line 1
Address Line 2
City, State Zip Code
(555) 555-5555

SUMMARY OR OBJECTIVE
Include employment objective and/or summary of qualifications here.

SUMMARY OF SKILLS AND/OR EXPERIENCE

Skill or Experience
- Description
- Description

Skill or Experience
- Description
- Description

Skill or Experience
- Description
- Description

EMPLOYMENT HISTORY

Job Title
Employer
City, State
Dates

Job Title
Employer
City, State
Dates

EDUCATION

Type of Award of Degree:
Degree or Certification Name (GPA if relevant)
Minor if applicable
School Name – City, State

LICENSES

PROFESSIONAL MEMBERSHIPS OR ORGANIZATIONS
SHIRLEY ADAMS
1234 56th Avenue
Apartment #203
Tucson, AZ 85725
(520) 555-5555

SUMMARY

Dependable General Office Worker with more than 10 years of transferable experience. Proven clerical, customer service and communication skills in a variety of settings. Upbeat, positive attitude with a history of producing quality results and satisfied customers. Computer literate.

SELECTED SKILLS

General Office

- Organized and implemented group activities in an efficient manner
- Scheduled appointments and assured timely arrival
- Maintained accurate financial records, and paid all invoices on time
- Answered phones and took accurate messages
- Prepared reports and created documents using MS Word and WordPerfect
- Located desired information using the Internet

Customer Service

- Welcomed customers and visitors in a friendly and courteous manner
- Provided customers/clients with desired information in a timely manner
- Listened, calmed and assisted customers with concerns
- Established friendly and lasting relationships

Communication

- Utilized Internet email as an effective communication tool
- Answered phones in a courteous and professional manner
- Established rapport with diverse individuals and groups
- Demonstrated ability to express ideas in a team environment and influence action

RELATED VOLUNTEER EXPERIENCE

| General Office Volunteer | Salvation Army – Tucson, AZ | 5 Years |
| Elected Secretary        | Parent Teachers Association (ISD 01) – Tucson, AZ | 5 Years |
| Event Coordinator        | Neighborhood Involvement Program – Phoenix, AZ | 3 Years |
| Group/Activities Leader  | Girl Scouts of America – Phoenix, AZ | 4 Years |
| Family Manager           | Self-employed – Tucson, AZ | 7 Years |

EDUCATION

GED: Maricopa County Action Program, Phoenix, AZ
## Addendum A

### Description of Work/Study Position

<table>
<thead>
<tr>
<th>Company Name:</th>
<th>Job Title:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department/Group:</td>
<td>Location/Address:</td>
</tr>
<tr>
<td>Immediate Supervisor:</td>
<td>Title:</td>
</tr>
<tr>
<td>Telephone #:</td>
<td>Fax #:</td>
</tr>
<tr>
<td>E-Mail:</td>
<td>Start Date:</td>
</tr>
</tbody>
</table>

**Web Site:**

Will students be required to leave the work place at any time?  
(Please check one)?  
☐ Yes  ☐ No

If “Yes” please describe:

Click here to enter text.

### Job Description

**Work/Study Role and Responsibilities**

Type a description of the essential roles, responsibilities and activities a candidate may expect to assume in this position.

- 
- 
- 
- 

**Required/Desired Skills (Example, Word-Processing)**

1. 
2. 
3. 
4. 

**Most Important Performance Criteria:**

1. 
2. 
3. 

**Additional Notes**

Prepared By:  
Date: 

---

Cristo Rey High School Sacramento, Work-Study - 1/25/11
ADDENDUM A

DESCRIPTION OF WORK/STUDY POSITION

<table>
<thead>
<tr>
<th>Company Name:</th>
<th>Sacramento Air District</th>
<th>Job Title:</th>
<th>Land Use Intern</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department/Group:</td>
<td>LUTRAN</td>
<td>Location/Address:</td>
<td>SMAQMD</td>
</tr>
<tr>
<td>Immediate Supervisor:</td>
<td>Larry Robinson</td>
<td>Title:</td>
<td>Program Coordinator</td>
</tr>
<tr>
<td>Telephone #:</td>
<td>916.555.4875</td>
<td>Fax #:</td>
<td>916.555.4805</td>
</tr>
<tr>
<td>E-Mail:</td>
<td></td>
<td>Start Date:</td>
<td></td>
</tr>
<tr>
<td>Web Site:</td>
<td><a href="http://www.airquality.org">www.airquality.org</a></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Will students be required to leave the workplace at any time? (Please check one) □ Yes □ No
If “Yes” please describe: Click here to enter text.

Job Description

WORK/STUDY ROLE AND RESPONSIBILITIES

[Type a description of the essential roles, responsibilities and activities a candidate can expect to assume in this position, using the Details style. For bullets, use the Bulleted List style.]

- Identifying the geographic boundaries of specific plan areas
- Creating mapping polygons of these boundaries
- Update manual site location map
- Potentially assist in on-site construction and development site inspection (this would involve leaving the facility with a staff person)
- File documents, scan documents and retrieve files and documents
- Assist with reproduction and distribution of outreach materials (this could involve participation in workshops that occur off-site)

REQUIRED/DERIVED SKILLS (EXAMPLE, WORD-PROCESSING)

1. Ability to read a street map
2. Ability to look up geographic boundary information
3. Ability to file accurately
4. Basic computer skills
5. Ability to communicate accurately in English

MOST IMPORTANT PERFORMANCE CRITERIA:

1. Accuracy of information developed
2. Ability to work effectively with a team of individuals.
3. Ability to communicate information accurately.

Prepared By: Tim Taylor Date:
# ADDENDUM A
## DESCRIPTION OF WORK/STUDY POSITION

<table>
<thead>
<tr>
<th>Company Name:</th>
<th>Crocker Art Museum</th>
<th>Job Title:</th>
<th>Administrative/Education Assistant</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department/Group:</td>
<td>Administration</td>
<td>Location/Address:</td>
<td>216 O St. Sacramento, CA 95814</td>
</tr>
<tr>
<td>Immediate Supervisor:</td>
<td>Rika Nelson</td>
<td>Title:</td>
<td>Coordinator of Volunteers</td>
</tr>
<tr>
<td>Telephone #:</td>
<td>(916) 555-7382</td>
<td>Fax #:</td>
<td>(916) 555-7372</td>
</tr>
<tr>
<td>E-Mail:</td>
<td></td>
<td>Start Date:</td>
<td></td>
</tr>
<tr>
<td>Web Site:</td>
<td><a href="http://www.Crockerartmuseum.org">www.Crockerartmuseum.org</a></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Will students be required to leave the work place at any time? (Please check one)?
- [ ] Yes
- [x] No

If "Yes" please describe: Click here to enter text.

## Job Description

### WORK/STUDY ROLE AND RESPONSIBILITIES

[Type a description of the essential roles, responsibilities and activities a candidate can expect to assume in this position, using the Details style. For bullets, use the Bulleted List style.]

- Preparing Materials for Educational Activities
- Volunteer Data entry and Management
- Various Office Tasks as Assigned
- Potential for answering phones, directing visitor questions

### REQUIRED/DESIRED SKILLS (EXAMPLE, WORD-PROCESSING)

1. Data Entry Skills
2. Arts and Crafts
3. Microsoft Excel/Word
4. Phone/Interpersonal Skills

### MOST IMPORTANT PERFORMANCE CRITERIA:

1. Positive Attitude
2. Accuracy of work completed

### ADDITIONAL NOTES

*Students will likely participate in museum educational programs such as tours, performances, etc. Students will also work with the public and a wide variety of Crocker Staff Members.*

Prepared By:           Date: